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Aula 2 - Jogo do Labirinto

João Pedro Mucheroni Covolan
Prof. Adj. Antônio Carlos Sementille
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Jogo do Labirinto

● Jogo composto de:
○ Uma caixa móvel
○ Uma bolinha de gude
○ Obstáculos
○ Um ponto de chegada

● Objetivo: fazer a bolinha atingir o 
ponto de chegada movimentando 
a caixa
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Etapas

● 1. Criar um projeto 3D com a cena “Primeira Fase”
● 2. Ajustar a posição da câmera e da iluminação (para ver o jogo de cima)
● 3. Criar a caixa e adicionar material e física
● 4. Adicionar script para movimentar a caixa e criar um prefab
● 5. Criar a bolinha e adicionar material, física e material físico
● 6. Adicionar script para voltar a bolinha para a posição inicial e criar prefab
● 7. Criar moeda e adicionar material
● 8. Adicionar script para capturar moeda, criar prefab e adicionar várias 

moedas na fase
● 9. Adicionar texto com pontuação e script para atualizar o texto
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Etapas (cont.)

● 10. Criar ponto de chegada e aplicar material
● 11. Criar script para exibir texto de fim de fase e passar para próxima fase e 

criar prefab
● 12. Criar a cena “Segunda Fase”, usando os prefabs e adicionando 

obstáculos

Obs.: Salvar a cena (Ctrl + S) a cada etapa para não perder o trabalho feito 
caso o Unity trave ou feche acidentalmente 
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Etapa 1

Criar um projeto 3D com a cena “Primeira Fase”
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Etapa 1

Selecionar 3D, escolher nome
e pasta e clicar em “CREATE”
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Etapa 1

Abrir a pasta “Scenes” (Cenas)
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Etapa 1

Clicar com o botão direito em “SampleScene” e clicar em “Rename” (Ou
selecionar a cena e clicar F2)
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Etapa 1

Trocar o nome para “Primeira Fase” e pressionar <Enter>
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Etapa 1

Aparecerá a janela acima. Clicar em “Reload”
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Etapa 2

Ajustar a posição da câmera e da iluminação (para ver o jogo de cima)
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Etapa 2
Selecionar a câmera principal
(Main Camera) na janela de
hierarquia e mudar os valores
de translação e rotação:

● Translação: (0, 15, 0)
● Rotação: (90, -90, 0)
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Etapa 2
Selecionar a iluminação
principal (Directional Light) na
janela de hierarquia e mudar os
valores de translação e
rotação:

● Translação: (0, 10, 0)
● Rotação: (90, 0, 0)
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Etapa 2

Resultado: Câmera com visão de cima e iluminação por cima (em relação às
coordenadas do mundo)
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Etapa 3

Criar a caixa e adicionar material e física
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Etapa 3
Criar um GameObject vazio na
janela de hierarquia com nome
“Caixa” e os seguintes valores
na transformada:

● Posição: (0, 0, 0)
● Rotação: (0, 0, 0)
● Escala: (1, 1, 1)
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Etapa 3
Criar seis cubos filhos de
“Caixa” na janela de
Hierarquia, com os seguintes
nomes, nesta ordem:

● Fundo
● Parede (1)
● Parede (2)
● Parede (3)
● Parede (4)
● Tampa
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Etapa 3
Mudar os valores das transformadas
dos filhos, conforme segue abaixo:
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Fundo:

● Translação: (0, 0, 0)
● Rotação: (0, 0, 0)
● Escala: (13, 1, 13)

Parede (1):

● Translação: (7, 0.5, 0)
● Rotação: (0, 0, 0)
● Escala: (1, 2, 13)
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Etapa 3
Mudar os valores das transformadas 
dos filhos, conforme segue abaixo:
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Parede (2):

● Translação: (-7, 0.5, 0)
● Rotação: (0, 0, 0)
● Escala: (1, 2, 13)

Parede (3):

● Translação: (0, 0.5, -7)
● Rotação: (0, 0, 0)
● Escala: (15, 2, 1)

Etapa 3
Mudar os valores das transformadas
dos filhos, conforme segue abaixo:
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Parede (4):

● Translação: (0, 0.5, 7)
● Rotação: (0, 0, 0)
● Escala: (15, 2, 1)

Tampa:

● Translação: (0, 2, 0)
● Rotação: (0, 0, 0)
● Escala: (15, 1, 15)
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Etapa 3
A ideia do objeto “Tampa” é servir
como uma tampa de vidro que impede
a bolinha de cair para fora da caixa

Por isso, o Mesh Renderer da tampa
deve ser desativado, tornando-a
invisível
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Etapa 3

Resultado: caixa vista em perspectiva na janela de visualização da cena
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Etapa 3
Adicionar material com textura a cada
parte da caixa, com exceção da tampa
(invisível)

Exemplo: textura de madeira gerada a
partir de uma imagem JPG e
adicionada aos objetos Fundo, e
Parede (1-4)

Obs.: Criar pastas para organizar os
materiais e outra com as imagens
usadas para criar texturas
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Etapa 3
Adicionar rigidbody ao objeto caixa,
para que possa interagir com a bolinha

Desmarcar a propriedade “Use
Gravity” para que a caixa não caia e
marcar a propriedade “Is Kinematic”
para que a bolinha e outros objetos
não apliquem força e desloquem a
caixa
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Etapa 3

Resultado: caixa vista em perspectiva na janela de visualização da cena
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Etapa 4

Adicionar script para movimentar a caixa e criar um prefab
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Etapa 4
Criar script com nome “ControlaCaixa”
e associar ao objeto “Caixa”. O script
permitirá rotacionar a caixa na vertical
e na horizontal

Obs.: Criar uma pasta para organizar
os scripts
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Etapa 4
Para rotacionar a caixa, usaremos os
eixos de entrada definidos nas
configurações do projeto. Para acessar
suas propriedades: Edit > Project
Settings...

0049125A - Realidade Aumentada - Prof. Sementille e João Pedro Mucheroni Covolan



0049125A – Realidade Aumentada 25/09/2019

Prof. Sementille e João Pedro Mucheroni Covolan 15

Etapa 4 Apagar os métodos “Start” e “Update”
(não serão usados), criar a variável
pública “velocidade” (velocidade da
rotação da caixa) e o método
“FixedUpdate”

Como estamos lidando com objetos
com física, é mais interessante usar o
método “FixedUpdate”, que é
executado apenas após a finalização
dos cálculos de física, do que o
método “Update”, atualizado a cada
frame
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Etapa 4
Adicionar em “FixedUpdate” o código
ao lado, que usa valor de entrada dos
eixos “Horizontal” (setas para a
esquerda e direita), “Vertical” (setas
para cima e para baixo) e da
velocidade para rotacionar a caixa
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Etapa 4
Salvar o código, selecionar na janela
de hierarquia o objeto “Caixa” e na
janela de inspeção configurar a
variável pública “Velocidade” com valor
100.
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Etapa 4

Criar uma pasta “Prefabs” e arrastar o objeto “Caixa” para dentro dela,
criando um prefab da caixa
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Etapa 5

Criar a bolinha e adicionar material, física e material físico
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Etapa 5
Criar uma esfera com o nome
“Bolinha” na janela de hierarquia (fora
da caixa) com os seguintes valores de
transformada:

● Translação: (0, 0, 0)
● Rotação: (0, 0, 0)
● Escala: (1, 1, 1)
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Etapa 5
Adicionar material à “Bolinha”.
Exemplo: material com Shader do tipo
“Standard”, Albedo com cor RGB (169,
172, 202), Metallic com valor 1 e
Smoothness com valor 0.52
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Etapa 5
Adicionar física ao objeto “Bolinha”

A propriedade “Use Gravity” deve estar
ativada, para que a bolinha caia na
caixa e se movimente conforme a
caixa rotaciona, e a propriedade “Is
Kinematic” deve estar desativada para
que a caixa e outros objetos apliquem
força e desloquem a bolinha
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Etapa 5
Criar um novo material físico (Assets >
Create > Physic Material). Configurar
as propriedades do material:

● Dynamic Friction: 0.5
● Static Friction: 0.5
● Bounciness: 0.5
● Friction Combine: Minimum
● Bounce Combine: Maximum

Essas propriedades determinam o
atrito e elasticidade do material físico
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Etapa 5
Adicionar o material físico ao colisor da
“Bolinha”, conforme imagem ao lado
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Etapa 6

Adicionar script para voltar a bolinha para a posição inicial e criar prefab
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Etapa 6
Criar script “Reinicia” e associar ao
objeto “Bolinha” para permitir que o
usuário retorne a bolinha à sua
posição e velocidade inicial e a caixa à
rotação inicial.

Criar a variável privada posInicial do
tipo Vector3 (ponto no espaço
tridimensional) para guardar a posição
da bolinha na fase.

Atribuir a posição da bolinha à variável
posInicial no método Start

0049125A - Realidade Aumentada - Prof. Sementille e João Pedro Mucheroni Covolan



0049125A – Realidade Aumentada 25/09/2019

Prof. Sementille e João Pedro Mucheroni Covolan 21

Etapa 6

Adicionar ao método Update o código ao lado que volta a “Bolinha” a sua
posição e velocidade inicial (0) e a caixa a sua rotação inicial (zero em todos os
eixos). Salvar o script
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Etapa 6
Arrastar a “Bolinha” da janela de
hierarquia para a pasta de prefabs da
janela de projeto, criando um prefab da
bolinha

Em seguida, selecionar novamente a
bolinha na janela de hierarquia e
alterar sua transformada:

● Translação: (0, 0.75, 0)
● Rotação: (0, 0, 0)
● Escala: (0.6, 0.6, 0.6)
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Etapa 6
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Resultado na área de visualização da cena

Etapa 7

Criar moeda e adicionar material
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Etapa 7
Criar um cilindro na janela de
hierarquia com o nome “Moeda” e
alterar a sua transformada:

● Translação: (0, 0, 0)
● Rotação: (90, 0, 0)
● Escala: (0.5, 0.05, 0.5)
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Etapa 7
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Adicionar material à “Moeda”.
Exemplo: material com Shader do tipo
“Standard”, Albedo com cor RGB (255,
248, 0), Metallic com valor 1 e
Smoothness com valor 0.5
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Etapa 8
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Adicionar script para capturar moeda, criar prefab e adicionar várias moedas na 
fase

Etapa 8
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Criar script “CapturaMoeda” e
adicionar ao objeto “Moeda”. O script
permitirá que as moedas desapareçam
ao entrar em contato com a “Bolinha”,
emitam um som, e sejam
contabilizados pontos para o usuário

Como é interessante que a moeda
seja apenas capturada e não interaja
fisicamente com a “Bolinha”, deve-se
ativar a propriedade “Is Trigger”
(gatilho) do colisor da moeda
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Etapa 8
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Apagar o método Start (não será
usado). Criar a variável pública e
estática “pontos” e iniciá-la com zero.
É importante que a variável seja
pública para que possa ser acessada
posteriormente pelo script que irá
exibir os pontos na tela. Também é
importante que seja estática porque a
pontuação é apenas uma em todo o
jogo

Etapa 8
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Criar também a variável pública
somMoeda do tipo AudioClip, que
guardará o som emitido quando a
moeda é capturada
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Etapa 8
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No método Update, aplicar o script ao
lado para que as moedas façam uma
animação de rodar

Etapa 8
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Criar o método OnTriggerEnter, que será executado quando algum objeto colidir
com a moeda, cujo colisor é um “Trigger” (gatilho).

Se o objeto que colidiu com a moeda for a “Bolinha”, um ponto será adicionado,
um som será emitido e a moeda será destruída, conforme código a seguir. O
som é emitido na posição da câmera principal porque é ela que “ouve” os sons e,
portanto, emitir próximo dela torna o som mais audível
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Etapa 8
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Etapa 8
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Importar um áudio para o projeto
(Assets > Import New Asset...) e
associar esse áudio à variável pública
“somMoeda” no janela de inspeção,
como na imagem ao lado

Obs.: Criar uma pasta para organizar
os áudios
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Etapa 8
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Arrastar objeto “Moeda” para janela de
projeto dentro da pasta de prefabs,
criando assim um prefab da “Moeda”.

Deletar “Moeda” da janela de
hierarquia. Criar um GameObject vazio
filho de “Caixa” com o nome “Moedas”
e os seguintes valores de
transformada:

● Posição: (0, 0, 0)
● Rotação: (0, 0, 0)
● Escala: (1, 1, 1)

Etapa 8
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Criar várias moedas, filhas do objeto
“Moedas”, a partir do prefab e espalhar
pelo interior da caixa. Exemplo: oito
moedas, com nome “Moeda(1-8)”, com
as seguintes posições no espaço: (-2,
0.75, -5.5), (2, 0.75, -5.5), (-2, 0.75,
5.5), (2, 0.75, 5.5), (-5.5, 0.75, -2), (-
5.5, 0.75, 2), (5.5, 0.75, -2), (5.5, 0.75,
2)
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Etapa 8
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Resultado na visualização da cena

Etapa 9
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Adicionar texto com pontuação e script para atualizar o texto
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Etapa 9
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Criar um “Canvas” na janela de
hierarquia para inserir o texto com a
pontuação. GameObject > UI > Text

Serão criados automaticamente dois
objetos: “Canvas” e “EventSystem”.
Canvas é o anteparo para escrever os
textos na tela. Ele já virá com um
objeto de texto (“Text”) como seu filho

Etapa 9
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Renomear o objeto “Text” para
“TextoPontos”

No componente “Rect Transform” do
objeto “TextoPontos” configurar as
propriedade Pox X = 297.9 e Pos Y =
131. No componente Text, configurar a
propriedade Text = “Pontos:” e a
propriedade Font Style = Bold
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Etapa 9
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Ativar também a propriedade Best Fit e
mudar a cor do texto para branco puro

Etapa 9
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Duplicar o objeto “TextoPontos”
(Ctrl+D) e dar ao novo objeto gerado o
nome “Valor”. Tornar “Valor” filho de
“TextoPontos”

No componente Rect Transform de
“Valor”, configurar a posição (0, 0, 0) e
no componente Text, subitem
Paragraph, selecionar alinhamento do
texto à direita, conforme a imagem ao
lado
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Etapa 9
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Criar o script “AtualizaPontos” e
adicionar ao objeto “Valor”. Apagar a
função Start (não será usada)

Inserir a biblioteca UnityEngine.Ui,
através do comando “using
UnityEngine.UI;”

Na função update, inserir o código ao
lado, que atualiza a exibição da
pontuação

Etapa 9
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Resultado na visualização do jogo
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Etapa 10
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Criar ponto de chegada e aplicar material

Etapa 10
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Criar um GameObject vazio com o
nome “Objetivo”, com os seguintes
valores de transformada:

● Posição: (0, 0, 0)
● Rotação: (0, 0, 0)
● Escala: (1, 1, 1)

Criar quatro cubos filhos de “Objetivo”
com os nomes:

● Lateral (1)
● Lateral (2)
● Fundo
● Gatilho
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Etapa 10
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Aplicar aos cubos os seguintes valores
na transformada:

Lateral (1)

● Posição: (0, 0, -0.6)
● Rotação: (0, 0, 0)
● Escala: (1, 1, 0.2)

Lateral (2)

● Posição: (0, 0, 0.6)
● Rotação: (0, 0, 0)
● Escala: (1, 1, 0.2)

Etapa 10
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Aplicar aos cubos os seguintes valores
na transformada:

Fundo

● Posição: (0.4, 0, 0)
● Rotação: (0, 0, 0)
● Escala: (0.2, 1, 1)

Gatilho

● Posição: (0.1, 0, 0)
● Rotação: (0, 0, 0)
● Escala: (0.4, 1, 1)
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O objeto “Gatilho” servirá apenas para
detectar que a “Bolinha” entrou na
caixinha de chegada. Portanto, não
será visível e por isso seu Mesh
Renderer deverá ser desativado

Além disso, a propriedade “Is Trigger”
do seu colisor deve ser ativada

Etapa 10
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Aplicar um material às partes visíveis
do objeto “Objetivo”. Exemplo: material
com cor azul pura: Shader “Standard”,
Albedo com cor RGB (0, 0, 255)
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Criar script para exibir texto de fim de fase e passar para próxima fase e criar 
prefab

Etapa 11
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Criar um novo objeto de texto filho de
“Canvas” com o nome
“TextoProximaFase”, com os mesmos
valores nas propriedades do objeto
“TextoPontos”, porém com valor Pos Y
= -5 no componente Rect Transform e
com o texto “Pressione <Enter> para ir
para a próxima fase” na propriedade
Text do componente Text

Além disso, o componente Text deve
ser desabilitado
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Criar script “PassaFase” e associar ao
objeto “Gatilho”. Esse script será
responsável por exibir uma mensagem
de fim de fase para o jogador e
carregar a próxima fase

Adicionar no script as bibliotecas
UnityEngine.UI (“using
UnityEngine.UI;”) e
UnityEngine.SceneManagement
(“using
UnityEngine.SceneManagement;”)

Etapa 11
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Criar a variável privada do tipo bool
(lógica) chamada “fim”, que indicará se
a “Bolinha” já entrou na caixinha de
chegada

Criar também a string (cadeia de
caracteres) pública “proximaFase” que
guardará o nome da cena que contém
a próxima fase
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No método Start, atribuir fim = false, já
que a fase acabou de iniciar

No método OnTriggerEnter, executado
quando um objeto entra na caixinha de
chegada, verificar se esse objeto é a
“Bolinha” e, se for, aplicar o código ao
lado (dentro do “if”), que determina que
a fase chegou no fim, remove o
Rigidbody da “Bolinha”, torna-a filha da
caixa, para que ela não se mova mais,
exibe o texto de fim de fase e
contabiliza mais 10 pontos para o
jogador

Etapa 11
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No método Update, verificar se a fase
chegou ao fim e se o usuário
pressionou <Enter> (Return),
confirmando que está pronto para ir
para a próximo. Em caso afirmativo,
carregar a cena com a próxima fase

Salvar o script
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Na janela de hierarquia, selecionar o
objeto “Gatilho” e na janela de
inspeção, atribuir para a variável
proximaFase (Proxima Fase) o valor
“Primeira Fase”, já que até o momento
não temos outra fase para carregar

Assim, ao chegar ao fim da primeira
fase, ela será carregada novamente

Etapa 11
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Arrastar o objeto “Objetivo” à janela de
projeto na pasta de prefabs, criando
um prefab da caixinha de chegada

Em seguida, selecionar novamente
“Objetivo” na janela de hierarquia,
torná-lo filho de “Caixa” e, na janela de
inspeção, alterar a posição da
transformada para (6, 1, 0)
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Criar a cena “Segunda Fase”, usando os prefabs e adicionando obstáculos

Etapa 12
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Criar uma nova cena a partir da cena
atual (“File > Save As...” ou Ctrl + Shift
+ S) e salvar a cena com o nome
“Segunda Fase”

Mudar a bolinha e a caixinha de saída
(“Objetivo”) de posição, distribuir
moedas no interior da caixa e
adicionar obstáculos
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Exemplo: “Bolinha” na posição (-5.5,
0.75, -5.5), “Objetivo” na posição (0, 1,
0) com rotação (0, 180, 0) e 13
moedas nas posições: (-2, 0.75, -5.5),
(2, 0.75, -5.5), (5.92, 0.75, -5.5 ),
(5.92, 0.75, -0.02 ), (5.79, 0.75, 5.87 ),
(1.82, 0.75, 5.83), (-2.07, 0.75, 5.81),
(-6.02, 0.75, 5.81), (-6.02, 0.75, -0.06),
(-3.54, 0.75, -2.48), (-1.63, 0.75, -
2.48), (-1.73, 0.75, -0.84), (-3.54,
0.75, -0.84)

Etapa 12
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Criar um novo material para os
obstáculos. Exemplo: material com
Shader “Legacy Shaders/Diffuse”,
Main Color RGB (135, 69, 69) e textura
de madeira (a mesma da caixa)
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Criar um GameObject vazio chamado
“Labirinto”, filho do objeto “Caixa” com
os valores de transformada:

● Posição: (0, 0, 0)
● Rotação: (0, 0, 0)
● Escala: (1, 1, 1)

Inserir uma série de obstáculos como
filhos de “Labirinto”

Etapa 12
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Exemplo: criar cinco cubos filhos de “Labirinto” com os nomes “Parede (5-10)”
com os seguintes valores de transformada:

Parede (5)

● Posição: (5, 1, 0.5)
● Escala: (1, 1, 6)

Parede (6)

● Posição: (-5, 1, 0)
● Escala: (1, 1, 7)

Parede (7)

● Posição: (0, 1, -4)
● Escala: (11, 1, 1)

Parede (8)

● Posição: (0, 1, 4)
● Escala: (11, 1, 1)

Parede (9)

● Posição: (2.1, 1, -0.5)
● Escala: (1, 1, 6)

Parede (10)

● Posição: (-0.38, 1, 2)
● Escala: (4, 1, 1)
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Voltar para a primeira cena e mudar o
valor da variável “proximaFase”
(Proxima Fase) para “Segunda Fase”

Etapa 12
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Adicionar a cena da primeira fase em
Build Settings (File > Build Settings…
> Add Open Scenes)

Abrir a segunda cena e adicioná-la da
mesma forma

É necessário que se faça isso para
que uma cena consiga carregar a
outra

O jogo está pronto :)
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Resultado na visualização da cena


